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Introduction
Congratulations on choosing Tabs3 software! We are pleased to welcome you to the satisfied and
growing family of Tabs3 and PracticeMaster users. Our software is backed by our professional staff,
which has extensive experience in accounting, program development, and customer support. Our
goal is to provide law firms with the highest level of quality products and service. We are committed
to providing our customers with user-proven, reliable software.

Purpose of Guide
This Administrator Guide is a single comprehensive guide for setting up all of the software
including Tabs3 Billing, PracticeMaster, and the Tabs3 Financial software, which consists of Tabs3
Accounts Payable Software (APS), Tabs3 General Ledger Software (GLS), and Tabs3 Trust Accounting
Software (TAS). This guide is written for the person who configures the software and performs
routine maintenance, typically the Office Administrator or Billing Manager.
A separate Installation Guide includes information for installing the software. The Installation
Guide is written for the person who installs the software and is responsible for IT.
Additional guides for separate software features are also available. All guides are available on our
Web site at:

Tabs3.com/support/docs.html

Knowledge Base
You may be referred to additional detailed information located in our Knowledge Base on the
Internet at:

support.tabs3.com

Additional Resources
A comprehensive list of all resources for Tabs3 software can be found on page 81.

Customer Service is Important
We understand that customer support is an important part of customer satisfaction. When you
purchase a Tabs3 software license, you have our assurance of customer service and product support.
Product support plays a key role in our customer service philosophy. Our Technical Support staff is
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dedicated to helping you get the most from the software by answering technical questions about
the product and how it works.
If you have a question or problem concerning the software, we recommend these steps:
1. Check the product documentation including the Help provided with the software. Often,
you’ll find the answer to a question there.
2. Refer to our Knowledge Base on the Internet. Our Knowledge Base contains extensive
information on Error Troubleshooting, Networking & Windows Issues, “How To” Articles and
Product-Related Articles. Our Knowledge Base can be launched from the Help | Internet
Resources | Knowledge Base menu options in the software or found at:

support.Tabs3.com
3. Contact the consultant from whom you purchased the software license. If you can’t find the
answer in the product documentation, your consultant may be able to assist you.
4. Call our Technical Support Department at (402) 419-2210. Before you make the call, gather all
information pertaining to the problem. We will need to know the serial number of the
software, which can be found via the Help | About menus in the software.
5. Email the Technical Support Department. Our support team responds to emails during office
hours. Our goal is to respond to your question within one business day. Please keep in mind
that time-sensitive and complex issues are better handled over the phone. To request email
support, visit Tabs3.com/support.

Register the Software
The software must be registered in order to receive technical support and maintenance benefits.
Registering the software establishes you as the licensed user.
▶ To register the software
l

From the Help menu, point to Internet Resources and select Register Software.
...or...

l

Go to Tabs3.com/register

-2-

Tabs3 Software Administrator Guide

Setting Up the Basics
After installing the software, you need to set up your firm, access profiles, and users. Setting up
these files is performed using System Configuration.

Starting System Configuration
You can start the System Configuration software using one of the following methods.

Method

Steps

Windows Desktop

From the Desktop, click the System Configuration shortcut.

Windows Start menu

For information on accessing Tabs3 software via the Start menu in
each version of Windows, see Knowledge Base Article R11794,
“Windows Start Menu Options” (support.Tabs3.com).

Tabs3 or PracticeMaster

From Tabs3 or PracticeMaster, click the

icon on the application

toolbar.
More Info: For more information on accessing Tabs3 software via the Start menu in each version
of Windows, see Knowledge Base Article R11794, “Windows Start Menu Options”
(support.Tabs3.com).

Setting Up the Firm
The Firm Information program includes the firm’s name, address, telephone, and other basic
information.
▶ To set up your firm information
1. From System Configuration, click the File menu, point to Open, and then select Firm.
2. The Firm Information window will be displayed.
3. Enter your firm information.
4. Click

to save the information.

5. Close the window.
Note: Firm information can be changed at any time. Refer to the Changing Firm Information Help
topic for complete details regarding other areas in the software that may also need to be changed.
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Figure 1, Firm Information window

Setting Up Access Profiles
Access profiles are used to designate which programs and functions are accessible by the users who
are associated with the access profile. You can define as many access profiles as you like. Rights for
each access profile can be as broad or limited as needed. For example, you may want to have an
access profile where users can view calendar information but not have access to billing or
accounting information. You may want to have an access profile that limits who has access to the
General Ledger software.
When you set up users, you will assign one or more access profiles to each user.
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Figure 2, Access Profiles - System Activity tab

Manager Access Profile

Figure 3, Access Profiles - Tabs3 tab

A predefined Manager access profile is provided with the
software. Users who are associated with the manager
access profile have all rights to all functions in all software.
The Manager access profile cannot be edited or deleted.
Additionally, there are certain tasks that can only be
performed by managers, such as resetting users, adding or
deleting users, editing other users, and more. A complete
list of manager exclusive tasks can be found in the
Manager Access Profile topic in Help.
Best Practice: We recommend limiting the number of
users who are given manager rights.

▶ To add an Access Profile
1. From System Configuration, click the File menu, point to Open, and then select Access
Profile.
2. The Access Profile window will be displayed.
a. In the Access ID field, enter a shortcut name using up to 8 characters.
b. In the Access Name field, enter up to 30 characters for the full name.
c. Under System Options, select which functions, if any, that members of this access
profile can access in System Configuration.
d. Under Back Up/Restore, select which functions, if any, this members of this access
profile can access in any of the software.
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3. Click the Tabs3 tab at the top of the window.
a. The first group of functions, Client Information is highlighted. Under Functions,
select which functions members of this access profile can access. You can use the
Allow and Disallow buttons at the bottom of the window to easily select multiple
rights at the same time.
b. Select the next group of functions, Fee, Cost, Payment & Client Funds Transactions,
and set the rights as desired.
c. Continue with selecting each group of functions and setting the rights as desired.
4. Click each of the tabs at the top of the window and set the rights as desired.
5. Click

to save the information.

6. Click

if you want to add additional access profiles.

More Info: A complete listing of the detail access rights for all systems can be found in Knowledge
Base article R11749, “Access Rights” (support.Tabs3.com).
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Setting Up Users
You will need to set up a user ID for each
user who will be using the software
(Figure 4).

Figure 4, User Configuration window

▶ To add a User ID
1. From System Configuration, click the File menu, point to Open, and then select Users.
2. Click the

button to add a new record.

3. The User Configuration window will be displayed.
a. In the User ID field, enter a unique shortcut name of up to 8 characters. You can use
letters, numbers, and the underscore character.
b. Enter a password in the Password and Confirm Password fields. Passwords are
forced to uppercase letters. Up to 20 characters, numbers, or symbols can be used.

-7-

Tabs3 Software Administrator Guide

c. Under User Information, enter the remaining user information.
d. Under Options, select the desired options.
More Info: Information regarding Calendar Rights can be found on page 47.
Information regarding Tabs3 Connect can be found on page 71.
e. Under Currently Assigned Access Profiles, select which access profile(s) the user
will belong to.
More Info: Additional information regarding assigning Tabs3/PracticeMaster
Timekeepers can be found on page 7.
4. Click

to save the information.

5. Click

if you want to add additional users.

Note: Users can change their own User Name, Initials, Password, Email Address, Calendar Colors
and Calendar Rights if they belong to an access profile that has been assigned access rights to
User Configuration. However, only managers can change access profile assignments, timekeeper
assignments, or add new users to the user file.
Blank User ID

A predefined User ID is provided with the software. This
user is named (BLANK) and is assigned to the manager
profile.
Best Practice: Once you have set up another manager
user, we recommend marking the (BLANK) User ID
inactive in order to preserve system security.

Shared Resources

Set up your shared resources as users for scheduling
purposes in the PracticeMaster Calendar. Resources that
you may want to set up as users include rooms, projectors,
easels, laptops, tablets, company vehicles, etc. For
example, set up each conference room as a user. Then,
when you need to schedule a meeting in that room, select
each attendee and the room to easily find an open
timeslot.

Outlook Integration

A separate program for configuring Outlook integration
with PracticeMaster for each user is available in
Maintenance | Integration | Outlook Synchronization.
Additional information can be found in Knowledge Base
article R11400, Outlook Integration Guide.
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Security Overview
Tabs3 software offers multiple layers of security.
Access Profiles

Access profiles are created to assign rights to the various
software systems and menu options (page 4).

User ID

User IDs are created for each person who will have access
to the software. When defining User IDs, you will also
assign one or more access profiles to which they belong.

Password

Passwords are assigned to User IDs.

Secure Clients

Clients can be set up as secure clients, thereby allowing
you to specify exactly which User IDs have access to each
secure client. Clients who are designated as secure clients
cannot be seen by users unless the User ID being used has
manager rights or has been assigned access to the secure
client. Clients marked as secure are secure in Tabs3 Billing,
PracticeMaster, and Tabs3 Trust Accounting Software.
Note: When a client is designated as secure, the client’s
contact information is stored in the Client file instead of
the Contact file. This is because contact information is
viewable by all users with browse rights to the Contact
file.

Timekeeper

You can set up a User ID so the user has access to a
particular timekeeper’s transactions but does not have
access to other timekeeper’s transactions. This is useful in
situations where you have an employee who is responsible
for a particular timekeeper but you want to restrict the
employee from accessing any work performed by other
timekeepers in the firm. Tabs3 Billing timekeepers can be
assigned to a User ID by selecting the Assign
Tabs3/PracticeMaster Timekeepers check box in System
Configuration.

Calendar Security

Calendar records in PracticeMaster can be designated as
public or private. All public calendar entries can be viewed
by all users. Users can designate which users will have:
l

edit rights to their public calendar records;

l

browse rights to their private calendar records; and
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l

edit rights to their private calendar records.

These rights allow the firm and users to implement
sophisticated access rights for their calendar entries. For
example, a timekeeper can designate that only his
secretary and partner have edit rights for his public
calendar records, only his secretary has browse rights to
his private calendar records and nobody has edit rights to
his private calendar records. PracticeMaster calendar
rights are implemented via the Calendar Rights button in
the User Configuration program of System Configuration.
More Info: Additional information regarding security can be found in the following Knowledge
Base articles at support.Tabs3.com:
l
l

Knowledge Base article R11652, “Access Rights”
Knowledge Base article R11459, “Ethical Walls in Tabs3 Software”
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Setting Up Groups
Once users have been defined, you can set up
groups. Groups are composed of various users
primarily for PracticeMaster calendaring,
scheduling, filtering, and eNote purposes.

Figure 5, Group Configuration window

▶ To add a group
1. From System Configuration, click the File menu, point to Open, and then select Group.
2. The Group Configuration window will be displayed.
a. In the Group ID field, enter an 8-character group ID.
b. In the Group Name field, enter the name of the group.
c. Under Users in the Group, click the check mark column for each user who is a
member of the group.
3. Click

to save the information.

4. Close the window.
Tip: Groups are optional and can be defined later. Think about scheduling purposes when
setting up groups. You can also look at the various groups you use for email purposes as a
starting point. For example, you may want to define a separate group for each department,
a group for all partners, or a group for all staff who work with a particular attorney.
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Defining the Format for Clients and Matters
Once you have defined firm information, access profiles, users, and groups, you can configure
printers, as discussed on page 13. However, when you start the software to configure the printers,
the Customization window will be displayed. You must save the Customization information before
you can use the software. Although this guide includes detailed information regarding
Customization for each of the software products in later sections, there is one area in Customization
that is common to Tabs3 Billing, PracticeMaster, and Trust Accounting (TAS), and that is the
configuration of the Client ID. The Client ID represents your client and matter numbering scheme.
This section discusses how the Client ID format is defined.
Two fields named Key Type and Decimal Places are used to determine your client numbering
scheme. These fields are typically defined in Tabs3 Customization first. Once defined in Tabs3
Customization, the information is mirrored to PracticeMaster Customization and TAS Customization.
There are three different Key Types: Numeric, Mixed, or Alpha. All Client IDs can have a maximum of
12 characters including an optional decimal point. Typically the client portion of the Client ID is left
of the decimal and the matter number is right of the decimal. The 12-character limit for Client IDs
includes the portion on the left side of the decimal, the portion on the right side of the decimal, and
the decimal itself.
The Decimal Places determines the number of digits for the matter position. Many firms will use 2 or
3 to start with.

Key Type

Description

Numeric

A Numeric Key Type allows only numbers in the client and matter portions of the
Client ID. 123.45, 20.001, and 5000.110701 are all examples of a Numeric Client ID.

Mixed

A Mixed Key Type allows alpha or numeric characters in the client portion of the
Client ID but only allows numeric characters in the matter portion of the ID. ABC.01,
DE12.004, and Smith.110801 are all examples of a Mixed Key Type.

Alpha

An Alpha Key Type allows both alpha and numeric characters in the client and
matter portions of the Client ID. ABC.DE and FG12.H34 are examples of an Alpha Key
Type.

There are advantages to using a Numeric Key Type. When using a Numeric Key Type, the primary
advantage is that Tabs3 can automatically assign new Client IDs and Matter IDs. When using a Mixed
Key Type, Tabs3 can automatically assign new Matter IDs, but not new Client IDs.
Best Practice: If you are not sure which Key Type to use, we recommend using a Numeric Key
Type.
You will need to define your Key Type and Decimal Places before using Tabs3 Billing,
PracticeMaster, and Trust Accounting.
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Setting Up Printers
Each workstation that uses Tabs3 software can define its own default printer. This printer is used for
printing reports.
▶ To define the default report printer
1. From the File menu, select Print Setup.
2. The Printer Setup window will open.
3. In the Printer field, select the desired default printer.
Tip: Click the Page Setup and Advanced Printing Features to view the different options available.
In addition to the default report printer, each workstation maintains a default Tabs3 Billing final
statement printer, a default Tabs3 Billing draft statement printer, a default APS check printer, and a
default TAS check printer. These printers are defined when using those features. Additional print
options for printing statements and checks are available when accessing the Print Setup program in
Tabs3 Billing, APS, and TAS.

Figure 6, Printer Setup with Automatic Font Selection
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Figure 8, Page Setup

Figure 9, Advanced Printing Features

Figure 10, APS Check Printer Setup

Figure 11, TAS Check Printer Setup

More Info: Complete details regarding print options can be found in Help.
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Navigating Tabs3 and PracticeMaster
Each user can select certain settings, and then customize various sections depending on those
settings, to personalize their navigation throughout the software.

Choose Theme Settings
The Theme Settings determines the navigation options and appearance of each Tabs3 Software
program.

Figure 12, Tabs3 Theme Settings

Figure 13, Text Size tab

You can change the Theme Settings of each product to include the navigation features you want on
the General Settings tab. On the Text Size tab, you can customize the text size used in windows,
menus, page tabs, lists, and messages.
▶ To configure Theme Settings
1. From the application menu, click View | Theme Settings.
2. On the General Settings tab, select the Navigation options you want to in windows, menus,
page tabs, lists, and messages include, and clear the navigation options you want to remove.
3. On the Text Size tab, select the text size you want to be used for windows, menus, page
tabs, lists, and messages in the software. Each workstation will show a Recommended setting
based on your operating system, resolution, and scaling options.
4. Click OK to use the new theme options.
You can also use the Set to Standard Theme button to select the navigation options included by
default, or Set to Classic Theme to select the navigation options used in previous versions of the
software.
For additional information on changing text size, see Knowledge Base Article R11778, “Customizing
Fonts and Colors in Tabs3 Software”.
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Customizing Quick Launch
When the Quick Launch pane is enabled in Theme Settings, it is shown on the left side of the
application window. The Quick Launch pane provides access to all programs and reports
(collectively referred to as actions) in the application via the Search Actions box. It also provides
one-click access to your recent and frequently used actions and matters.

Figure 14, PracticeMaster Quick Launch

Figure 15, APS Quick Launch

You can customize the Quick Launch to provide easy access to your most used actions and matters.
▶ To automatically hide the Quick Launch when not in use
l

Click

to the right of the Quick Launch pane heading.

When hidden, only the Quick Launch button is shown on the left side of the screen. Moving your
mouse over this button will cause the Quick Launch pane to slide into view, allowing you to use it as
needed.
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▶ To always show the Quick Launch pane
1. Hover over the Quick Launch button to display the Quick Launch pane.
2. Click

to the right of the Quick Launch pane heading.

▶ To expand or collapse a section
l

Click the arrow to the left of the section name.

If an arrow pointing down is shown, the section is expanded and will show all of its contents. If an
arrow pointing right is shown, the section is collapsed and none of its contents will be shown.
▶ To move a section
1. Hover over the section name.
2. Click and drag the section to the desired position.
Note: The Home link, Search Actions field, and Application Toolbar in the Quick Launch pane
cannot be collapsed or moved.

Recent and Pinned Actions
In all Tabs3 Software programs, the last ten actions used are shown in a Recent Actions section on
the Quick Launch pane. Each user can pin frequently used actions so they are readily available.
Clicking an action in the Recent Actions or Pinned Actions section opens the program or report.
▶ To pin an action
1. Hover over an action in the Recent Actions section.
2. Click

to the right of the action.

The action will be removed from the Recent Actions section and placed in the Pinned Actions
section.
▶ To remove a pinned action
1. Hover over an action in the Pinned Actions section.
2. Click

to the right of the action.

The action will be removed from the Pinned Actions section and added to the top of the Recent
Matters section.
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▶ To move a pinned action
1. Hover over an action in the Pinned Actions section.
2. Click and drag the action to the desired position.

Recent and Pinned Matters
In Tabs3 and PracticeMaster, the last five matters used are shown in a Recent Matters section on the
Quick Launch pane. Each user can pin frequently used matters so they are readily available. Clicking
on a matter in the Recent Matters or Pinned Matters section opens the Client Manager in Tabs3
Billing (or Matter Manager in PracticeMaster) for that matter.
▶ To pin a matter
1. Hover over a matter in the Recent Matters section.
2. Click

to the right of the matter.

The matter will be removed from the Recent Matters section and placed in the Pinned Matters
section.
▶ To remove a pinned matter
1. Hover over a matter in the Pinned Matters section.
2. Click

to the right of the matter.

The matter will be removed from the Pinned Matters section and returned to the Recent Matters
section.
▶ To move a pinned matter
1. Hover over a matter in the Pinned Matters section.
2. Click and drag the action to the desired position.

Customizing the Home Page
The Home Page contains the following pages:
l

l

l

My Actions: The My Actions page can be customized in each product to include the most
frequently used programs and reports. Each user can customize their own actions.
All Actions: The All Actions tab is used to navigate the software and provides access all
features in the software. This tab is divided into groups. Clicking a group will display the
actions within that group.
Dashboard: The Dashboard displays key information sections.
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The following section explains how to customize the My Actions page.

Figure 16, PracticeMaster My Actions view

Figure 17, Customize My Actions

▶ To customize My Actions
1. From the My Actions view of the Home page, click the
(Customize My Actions) icon in
the top right corner.
a. To add a program or report, click the Add Actions button.
i. Select one or more actions and click the Add >> button.
ii. Click Finish to add the selected action(s) to the current group.
b. To add a group, click the Add Group button.
i. Specify a name for the group.
ii. Optionally specify a description and select an icon color for the group.
iii. Click Next, and optionally select one or more actions to add to the new
group.
iv. Click Finish to add the new group to the current group.
c. Reorder actions or groups as desired.
i. Move the mouse pointer over the action or group.
ii. Drag the item to the desired location. You can move an action into a group
by dragging the item to the edge of the desired group.
iii. Release the pointer.
iv. The group will be reordered with the action or group in the new position.
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2. When finished customizing the various icon positions, click the Finish button in the top right
corner.

Figure 18, Add Group

Figure 19, Add Actions

Training Videos
You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/t3video.
Navigating and Using Tabs3 Video
Navigating and Using PracticeMaster Video
Customizing & Using Quick Launch Video
Using and Customizing My Actions Video
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Setting Up Tabs3 Billing
This section includes the information you need to start using Tabs3 Billing.

Tabs3 Billing Customization
The first time you start Tabs3 Billing after installing the software, the Customization window will be
opened. The Customization window consists of several tabs. There are a few fields that must be set
before proceeding. Complete details regarding the fields on each tab can be found in Help.

Figure 20, Tabs3 Customization - Main tab

Figure 21, Tabs3 Customization - Options tab

Figure 22, Tabs3 Customization - Rates tab

Figure 23, Tabs3 Customization Client Defaults tab
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▶ Configuring the Tabs3 Customization Window
1. Start Tabs3 Billing. The Customization window will be opened automatically. (Note: If the
Customization window does not open automatically, use the Utilities | Customization menu
to open the window.)
2. On the Main tab:
a. Specify the desired Key Type and Decimal Places as shown in Figure 20 and
described on page 12.
b. Specify the First Month of Reporting Year field. Most firms use January, but some
firms have a fiscal year that starts with a different month. (Note: This month is
different than the current reporting month.)
c. If you will be emailing Billing statements, select which Email Statements Method will
be used. The default is Outlook and can be changed later as desired. (More Info: More
information can be found in Help. A detailed comparison can be found in Knowledge
Base article R11409 - Comparing Outlook vs. SMTP for Email Statements.)
3. On the Options tab:
a. Specify whether you want statements numbered at the firm or client level in the
Statement Numbering field. (Note: We recommend numbering at the firm level so
you can easily search by statement number when entering payments.)
4. On the Rates tab:
a. If your state requires you to charge sales tax on services, expenses, or advances,
select the corresponding check box and enter the tax rate in the Rate 1 field.
b. If you would like to charge finance charge on past due balances, select the
corresponding check boxes and enter the annual rate in the Rate 1 field (e.g., enter
12.00 if you charge an annual finance charge of 12% per year).
5. On the Client Defaults tab:
a. Specify the defaults that will be used when adding a new client.
b. If assessing sales tax, under the Sales Tax section, select the default sales tax rate.
c. If assessing finance charge, select the Assess Finance Charge check box, the Rate,
and the number of Days past due before the finance charge will be assessed.
6. Click

to save the changes, then close Customization.

Note: If the Customization window was previously saved, the window will not be opened
automatically. Once Customization is saved, the Key Type and Decimal Places fields will be
dimmed and must be changed using the Change Key Type program.
More Info: Detailed information regarding Sales Tax and Finance Charge can be found in Help.
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Startup Files
Before using Tabs3 Billing, you need to set up the following startup files:
l
l
l
l
l
l

Timekeeper Level
Timekeeper
Category
Transaction Code (Tcode)
Billing Frequency
Optional Files

The following includes information on what information is stored in each of the startup files, as well
as step-by-step procedures for adding a record.
Note: If Starter Data was included when the software was installed, the above startup files will
already have data. You can review the contents of the separate files and edit as desired. At a
minimum, you need to enter your timekeeper information.
More Info: Detailed information regarding copying, changing, deleting, or renumbering records
can be found in the Help.
TAS Note: If you receive the “TAS is installed and must be configured before continuing” message,
you must configure Tabs3 Trust Accounting before continuing. Instructions for configuring TAS
can be found on page 53. Once you’ve configured TAS, return to this section. Make sure the Key
Type and Decimal Places is the same for Tabs3 Billing and Tabs3 Trust Accounting.

Timekeeper Level
Timekeeper levels are used for grouping
similar types of timekeepers. You can
optionally classify timekeepers by user
defined levels for purposes of default
billing rates, productivity reports and fee
summaries on statements. Examples of
timekeeper levels include senior partner,
partner, associate, paralegal, law clerk,
secretary, staff, etc. Up to 9 timekeeper
levels can be defined. Each timekeeper
level can have a 20-character
description.
Figure 24, Timekeeper Levels
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▶ To add a Timekeeper Level
1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.
2. Click the Misc Desc tab.
3. The Timekeeper Levels option is selected by default.
4. Enter the desired timekeeper levels.

Timekeeper
Timekeepers are different than users.
Users represent anyone who uses the
software, or a resource that needs to be
scheduled, such as a particular
conference room. Tabs3 Billing refers to
a timekeeper as any person whose time
is entered and/or billed, such as
attorneys, accountants, clerks,
paralegals, secretaries, etc.
Each timekeeper is assigned a
timekeeper number, name, initials,
timekeeper level classification, and up to
six hourly billing rates. Rate 1 is usually
designated as the normal billing rate for
most clients. Timekeepers can be marked
as inactive, which prevents fees and
costs from being entered for them.

Figure 25, Timekeeper

▶ To add a Timekeeper
1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.
2. By default, the Timekeeper tab is selected. Click

on the toolbar.

3. You can accept the automatically assigned timekeeper number or specify a different
timekeeper number. The automatically assigned timekeeper number defaults to the first
available timekeeper number.
4. Enter the remaining information for the timekeeper.
5. Click

on the toolbar to save the new timekeeper.
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Category
A category is an area of practice.
Categories are used to classify fee
services into related groups for reporting
purposes in Tabs3 Billing. Examples of
categories include Personal Injury,
Workers’ Compensation, Real Estate,
Family Law, Pro Bono, Consulting,
Individual Tax, Corporate Tax, Audit, etc.
Figure 26, Category

Each category is assigned a number and a description of up to 30 characters.
▶ To add a Category
1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.
2. Click the Category tab.
3. Click
on the toolbar. You can accept the automatically assigned category number or
specify a different category number. The automatically assigned category number defaults to
the first available category number.
4. After specifying the category number, enter the description and optional Task Based Billing
Code Set for the category.
5. Click

on the toolbar to save the new category.

Transaction Code (Tcode)
The term transaction code refers to the types of activities or services performed that relate to fees
and costs charged to clients and the resulting payments made by the client. Transaction codes are
also referred to as tcodes. Transactions are classified as fees, costs, payments, and client funds
transactions.
Up to 999 transaction codes can be defined. Each transaction code is assigned a number, an
abbreviation (Alpha Code) and a default description. Up to 1,000 characters are allowed in the
default description; however, additional text can be added when fees and costs are entered. Each
transaction code is designated as a fee, expense, or advance transaction (i.e., the Trans. Type field)
and also has a designated Type of 0-9. The Type is used to specify how Tabs3 Billing will treat a
transaction. A Type 0 (normal) transaction code will be the most frequently used transaction code
type. It represents a normal transaction such as fee, expense, and advance charges. Types 1 through
3 designate the transaction as a regular, fee or cost payment, respectively. A Type 4 transaction code
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is “description only” and will not allow an amount or number of hours to be entered. Type 5
transactions are miscellaneous transactions that are used for making a fee or cost entry when there is
no predefined description that fits your needs or to print the transaction code as a separate item
when subtotaling. A Type 6 transaction code is set aside specifically for progress fees.
Examples of fee transactions include office conference, telephone conference, review
correspondence, prepare motions, etc.
Tabs3 Billing classifies costs as either advances or expenses. Cost advances are “out of pocket” costs
that are incurred by the firm on behalf of the client. Cost advances are often used to reflect “hard”
costs or “direct” costs. Examples of cost advances are witness fees, medical costs, filing fees, etc.
Client expenses, on the other hand, are costs incurred by the firm without a direct cash outlay.
Expenses are considered “soft” costs or “indirect” costs. Examples of client expenses are photocopy
expenses, documentation preparation, per diems, etc. In addition to classifying costs as expenses or
advances, Tabs3 Billing also gives you the ability to further categorize expenses and advances by
Cost Type.
Best Practice: Tabs3 Billing ships with a default set of transaction codes in the starter data. You
can use these standard transaction codes until you decide what other transaction codes your firm
requires. Alternatively, you can get started by defining just three transaction codes: one Type 0
transaction code for fees; another Type 0 transaction code for expenses; and one Type 1
transaction code for payments.

Figure 27, Tcode

▶ To add a Transaction Code
1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.
2. Click the Tcode tab.
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3. Click
on the toolbar. You can accept the automatically assigned tcode number or specify
a different tcode number. The automatically assigned tcode number defaults to the first
available tcode number.
4. After specifying the tcode number, enter the remaining information for the transaction code.
5. Click

on the toolbar to save the new transaction code.

Billing Frequency
Billing frequencies are used by Tabs3 Billing to designate different billing intervals for clients and
matters and can be used to filter statements and reports. Each billing frequency consists of an 8character Billing Frequency ID, a single character for reporting purposes, and a description of up to
40 characters. For example, if your firm bills all of its clients on the same day once a month, then you
only need to define one billing frequency. You might call it “Monthly”, give it a description of
“Monthly Billing Clients”, and a Report Character of “M”. Other billing frequency examples include
quarterly billing frequencies, on demand clients, contingency clients, bi-monthly frequencies, etc.

Figure 28, Billing Frequency

▶ To add a Billing Frequency
1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.
2. Click the Bill Freq tab.
3. Enter the following information:
a. In the Billing Frequency ID, enter up to 8 characters to identify the billing frequency.
b. In the Description field, enter up to 40 characters to describe the billing frequency.
c. In the Report Character field, enter a single character to identify the billing
frequency on reports, usually a letter from A to Z.
4. Click

on the toolbar to save the billing frequency.
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Optional Files
The following table includes a list of optional files that your firm may be interested in defining.
Detailed information regarding these files can be found in Help.
Best Practice: Tabs3 Billing ships with a default set of cost types, task code sets, and task codes.
You can use this default information until you decide whether your firm will be using these files.

File Name

Home Page Location

Description

Location

All Actions | Setup | Location
Information

Define locations for firms with offices in
separate locations. Reports and
statements can be generated for clients
assigned to specific locations.

Cost Types

All Actions | Setup | Cost Type
Descriptions

Define optional cost types for grouping
similar types of costs for reporting
purposes.

Task Code Sets

All Actions | Setup | Task Code Set
Descriptions

Task code sets are used in conjunction
with task based billing. Use this option to
modify the name of each set of task
codes.

Task Codes

All Actions | Setup | Task Code
Information

Define Phase/Task codes, Activity codes,
and Expense code for task based billing
purposes.

Clients and Contacts
Once the startup files have been defined, you can enter clients and contacts. Contact records store
address, phone, and email information. Separate contact records can be maintained for
organizations and individuals. When you have a client that is an organization, you can define a
contact record for the organization as well as separate contact records for each person associated
with the organization. Maintaining separate contact records makes it possible to synchronize all of
your contacts and clients in PracticeMaster with Outlook and smartphones.
When you add a client, a contact record is created for the individual or organization. Contact records
can be used by other clients and matters.
More Info: Details regarding client and contact functionality can be found in the Clients &
Contacts Guide and in Help.
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Secure Client Note: Contact information for secure clients (i.e. address/phone/email) is stored and
edited in the Client file, rather than the Contact file. This is because contact records cannot be
marked as secure; contact information is viewable by all users with browse rights to the Contact
file. Likewise, address information for clients in matter mode is stored and edited in the Client file.

Training Videos
You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/t3video.
Contact Management Key Concepts Video
Client Overview Video
Working with Addresses Video
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Selecting a Transition Date
You will want to choose a transition date when you start using Tabs3 Billing for the first time. The
transition date will serve as a point of reference for existing clients’ accounts receivable balances and
work-in-process balances being transferred to Tabs3 Billing from your previous method of time
accounting and billing.
When first starting to use Tabs3 Billing, if desired, you can enter the information for each client
excluding accounts receivable information. You can then come back later and enter accounts
receivable information, provided this is done before running final statements for the client. This
strategy has the advantage of allowing you some flexibility in determining the exact transition date
for accounts receivable.

Entering Accounts Receivable Balances
There are different methods that can be used to implement beginning accounts receivable balances.
l

l

l

Method 1: - Entering Balances via the Client File
Accounts receivable figures can be entered in the Client File. Balances are entered on the A/R
& Fund Balances tab.
Method 2: - Entering Transactions and Running Final Statements
Accounts receivable figures can be generated by entering fee and cost transactions for the
accounts receivable balances, and then running final statements with the transactions and
updating those statements.
Method 3: - Custom Conversion
A custom conversion can be performed. Contact your local consultant or Software
Technology for more information.

Aging of accounts receivable is based on the date of each statement.
The following table includes the pros and cons of each method.
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Method
Method 1:
Entering Balances via
the Client File

Method 2:
Entering
Transactions and
Running Final
Statements

Pros
l
l

l

l

l

l

Method 3:
Custom Conversion
Customized to your
specifications

l

Cons

Fast
Can break out fees,
expenses, advances,
sales tax, and finance
charge

Can break out fees,
expenses, advances,
sales tax, and finance
charge
Optionally include
breakdown by working
timekeeper and/or cost
type
Optionally run separate
statements for aging
purposes
Provides greatest detail
Customized to your
specifications from any
software

l

l

l

l
l

l

l
l

No aging for balances consisting of
multiple statements
No breakdown by Working Timekeeper or
Cost Type
Receipts will be allocated to a single
designated R/A Timekeeper, Expense Cost
Type 0, and Advance Cost Type 0
Takes longer
Calculated finance charges may not
match original finance charge amount
Sales tax may be calculated differently
than originally billed

Additional charges
Additional time required

Method 1: Entering Balances via the Client File
Accounts receivable information can be entered on the A/R & Fund Balances tab of the client
program. When entering initial accounts receivable balances using the Client file, you can use one of
the following methods:
l
l

Enter one total amount due in the Fees Due, Expenses Due or Advances Due field; or
Enter separate amounts in the Fees Due, Expenses Due and Advances Due fields.

Additionally, amounts can be entered for Finance Charge Due, Fee Sales Tax Due, Expense Sales Tax
Due and Advance Sales Tax Due. The Last Statement Date can be specified for aging purposes and
assessing future finance charges on past due balances. All of the remaining fields (dates and
payment information) are optional and are only printed on reports to provide statistics about the
client.
Note: When using this method, a client’s accounts receivable balance must be entered before a
final statement is run for the client.
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When a new client is added with balance due information on the A/R and Fund Balances tab, a
client ledger record is automatically created for that client. Likewise, whenever an existing client who
has never been billed is changed from a zero balance due to a non-zero balance due, a client ledger
record is automatically created for that client.
This client ledger record is a statement record and includes all of the amounts entered on the A/R &
Fund Balances tab.
l

l
l
l

Any fees due entered are attributed to the specified R/A Timekeeper on that tab (if no R/A
Timekeeper is specified, then the primary timekeeper is used instead).
Any expenses due are attributed to expense cost type 0.
Any advances due are attributed to advance cost type 0.
The Last Statement Date on the A/R & Fund Balances tab is used as the date of this client
ledger record. If a Last Statement Date is not entered, the Date Opened from the Address
tab of client information is used.

Once a client ledger record has been created for the client (either by adding an accounts receivable
balance or by updating a statement), the accounts receivable fields on the A/R & Fund Balances tab
of client information become read-only and cannot be edited.
If you want to break down the accounts receivable by working timekeeper and cost types, instead of
using this method, you will need to enter separate transactions for each timekeeper and cost type
using the Fee Entry and Cost Entry program (i.e., Method 2).
If you want to break down the balance that clients owe you into separate statement amounts for
aging purposes, instead of using this method, you can do this by final billing and updating
transactions on separate statements with corresponding statement dates (i.e., Method 2). However,
this is a time consuming task.
In summary, the advantage of entering accounts receivable balances via the Client file is that it is
quick. Disadvantages include: 1) Only one aging period is used for the aggregate past due balance;
and 2) The fee amount due is automatically applied to the R/A Timekeeper for the client (specified
on the A/R & Fund Balances tab of the Client file), the expense amount due is automatically applied
to Expense Type 0, and the advance amount due is automatically applied to Advance Type 0.
Therefore, when payments are allocated, they will automatically be allocated to the R/A Timekeeper,
Expense Type 0 and/or Advance Type 0.

- 32 -

Tabs3 Software Administrator Guide

Method 2: Entering Transactions & Running Final
Statements
As an alternative to entering balance due information on the A/R & Fund Balances tab of the Client
file, you can enter fee, expense, and advance transactions for past due information, run a final
statement with those transactions, and update the final statements. If you want to use this
information and retain accurate aging information and billing history, you would have to repeat it
for each past due statement for each client. This method has the disadvantage of taking
considerably longer to accomplish. However, it has the advantages of maintaining accurate previous
historical information.
If you want to maintain billed and due information for each timekeeper and/or cost type, you must
use this method.
Sales Tax Note: If you want sales tax tracked separately, you can configure Tabs3 Billing for sales
tax and enter the fee and transactions with amounts that exclude the sales tax. Alternatively, you
can include sales tax in the transactions that you enter; however, receipts will not be allocated to
sales tax.
Finance Charge Note: Because finance charge is always calculated, we recommend using the
following method for entering beginning finance charge balances. Set up a separate finance
charge transaction code using an Expense or Advance Cost Type. Enter a separate transaction for
the cumulative finance charge amount (or a separate transaction for finance charge for each
statement). This method will let you track payment allocations for finance charge under the
designated cost type. (Note: When using this method, do not enable finance charge until after you
have completed entering the initial balances. Be aware that once finance charge is enabled,
finance charge will be assessed on the past due expense/advance balances. Reports will show
payments as allocating towards the designated expense or advance cost type.)

Method 3: Custom Conversion
Firms who are converting from other software systems may want to investigate the possibility of
having a custom conversion performed. For decades, we have successfully transitioned law firms to
Tabs3 software by performing custom data conversions. We tailor each conversion because each
firm has unique requirements and uses the software differently. If you’re interested, contact your
local consultant or request more information and a price estimate at www.Tabs3.com/conversions.

Examples for Entering A/R Balances
The following illustrates variations on how you might enter initial accounts receivable balances for a
client using Method 1 and Method 2.
For example, let’s say a client has the following balance due as of the selected transition date.
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Statement Statement
Date
Amount
March 31

$500

April 30

$300

Total
l

Expenses
Due

$400

$100

$250

$50

$650

$150

Method 1 Options - Enter Balances via the Client File
l
If you want the amounts due broken down for fees and expenses, you would enter
$650 in Fees Billed, $150 in Expenses Billed and April 30 for the Last Statement Date.
If desired, you could specify a single R/A Timekeeper for receipt allocation purposes.
l

l

Fees
Due

If you want a simple lump sum for the total amount, you would instead enter $800 in
Fees Billed and a Last Statement Date of April 30.

Method 2 Options - Entering Transactions and Running Final Statements
l
If you want amounts due broken down by aging period, you would enter four
transactions:
l
a fee transaction dated March 31 for $400,
l
a fee transaction dated April 30 for $250,
l
an expense transaction dated March 31 for $100; and
l
an expense transaction dated April 30 for $50.
l

l

Once all transactions are entered for all statements for all clients, you would run
batches of final statements and update the final statements using a process similar to
the following. It is important to note that the Update Statements program must be
run in between each final statement.
l
Run a final statement dated March 31 using a March 31 cut-off date.
l
Run the Update Statements program for the March 31 statement.
l
Run a final statement dated April 30 using an April 30 cut-off date.
l
Run the Update Statements program for the April 30 statement.
If you want amounts due broken down by timekeeper, you would use a process
similar to the one above, but instead of a single fee transaction for each statement,
you would enter separate fee transactions for each working timekeeper for each
statement.
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Entering Work-in-Process Balances
If any of your clients have work-in-process as of your transition date, you will need to enter this
information using the Fee Entry, Cost Entry, and Payment Entry programs.
Tip: Use a date for the work-in-process entries that is prior to your transition date. For example, if
you have selected a transition date of April 1, enter the work-in-process transactions using the
date that the transaction actually took place or a date of March 31 (as opposed to an April date).
This will allow for accurate April figures in the Worked section of the Timekeeper and Category
Productivity Reports.
There are three methods of transferring the fees from your previous billing system:
l

l
l

Make multiple fee entries for each client. This method gives you the most detail for client
statements and the most accuracy for productivity reports. It also takes the most time to
transfer work-in-process from your previous system; or
Make one fee entry for each timekeeper for each client that has work-in-process; or
Set up a timekeeper called “WIP CARRY-OVER”. Make one fee entry for each client that has
work-in-process. This method has the advantage of being the quickest method of
transferring work-in-process balances. However, the disadvantages include the inability to
allocate payments and productivity to working timekeepers.

In addition to entering fee work-in-process, you must also enter any expenses and advances that
have not been billed. You can do this one of two ways:
l

l

Make individual expense and advance entries for each client. This method gives you the
most detail for client statements. It also takes the most time to transfer work-in-process
information from your previous system; or
Set up two transaction codes called “WIP CARRY-OVER,” one for expenses and one for
advances. Make one cost entry for each client for each transaction code for the total amount
of expenses/advances unbilled at the time of starting Tabs3. This method has the advantage
of being the quickest method of transferring work-in-process balances. However, one
disadvantage is the inability to allocate payments and productivity to cost types.

Billing Rates
Tabs3 Billing is extremely flexible when it comes to defining billing rates. The two most common
methods of defining rates are the timekeeper rate and the client rate table.
l

l

You already defined timekeeper billing rates when you set up the timekeeper file (page 24).
You can define unique billing rates by client for each timekeeper if desired. These rates are
defined in a client rate table, which is accessed in the Tabs3 client file via the Rates tab.
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A complete discussion of the different billing methods and ways to set hourly rates can be found in
the Billing Methods Guide.

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.
How Rates Work Video
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Fee Compensation Rules
Tabs3 Billing provides the ability to define Fee Compensation Rules that can be used to designate
exactly how you want fee receipts allocated. These rules provide the ability to define multiple
originating timekeepers, threshold amounts and effective date ranges.
Fee compensation rules are defined for clients via a fee compensation rules table. Fee compensation
rules provide the ability to specify a percentage of a client’s fee receipts that you want allocated to a
specific primary, secondary, or originating timekeeper or to the firm. Each table can include multiple
rules. You have the ability to create rules for multiple originating, primary, and secondary
timekeepers as well as multiple rules for the same timekeeper. Rules can be based on a percentage of
receipts from:
l
l
l
l
l

all working timekeepers
selected working timekeepers
all working timekeepers assigned to a specific timekeeper level
statements within a specified date range
accumulated receipts within an amount range.

For example, your firm may want to allocate 10% of all fees received to the originating timekeeper.
Or you may want the primary timekeeper to receive 3% of all fees received and the firm to receive
1.85% of all fees received. Perhaps you want 25% of all fees received up to the first $1,000 allocated
to a specific timekeeper and 2% of all fees received through December 31 allocated to the primary
timekeeper. You may want to allocate a specific percentage of all fees received for paralegal billings
to the originating timekeeper. The combinations are endless.
You can define custom rules tables for each client. Or, you can define a table and share it with other
matters.
▶ To define a fee compensation rules table
1. From the Tabs3 Billing File menu, point to Open and select Client.
2. Click the Setup tab.
3. Under Payment Settings, click the Fee Compensation Rules button.
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Figure 29, Fee Compensation Rules button

Figure 30, Fee Compensation Rules Table

Tip: If no fee compensation rules are defined, fees will be allocated based on working timekeeper.
If you want to define fee compensation rules, define them before entering payments.
More Info: Complete details regarding fee compensation rules can be found in Help.
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.
Receipt Allocation Video (Fee Compensation Rules Segment)

Methods of Billing
Tabs3 Billing provides the ability to implement the following different billing methods:
l
l
l
l
l

Hourly Billing
Contingency Billing
Flat Fee Billing
Value Billing
Progress Billing

l
l
l
l

Retainer Billing
Split Billing
Task Based Billing
Threshold Billing

More Info: Complete details regarding each of these billing methods can be found in the Billing
Methods Guide and in Help.

Training Videos
You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/t3video.
Contingency Billing Video
Flat Fee Billing Video
Split Billing Video
Progress Billing Video
Task Based Billing and Taskbill Video

Statements
Tabs3 Billing lets you customize statements to print the way you want them to look. You can mail or
email statements as PDF files to your clients. Generate all of the emails and PDFs at once and
automatically insert variables such as the last payment date, outstanding balance, and other client
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information into the email. You can generate statements for any client or group of clients. Use the
Pre-Bill Tracking feature to print draft statements and track which ones are still under internal review.
More Info: The Statements Guide discusses the billing process, how to run statements, how to
use Pre-Bill Tracking, and other statement related utility programs in Tabs3 Billing.
More Info: The Statement Formatting Guide includes detailed information on how to format
statements to meet your firm’s needs.

Training Videos
You can view the following training video for more information. Clicking the link will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.
Statements Overview Video
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Setting Up the Statement Printer
Tabs3 Billing has additional printer configuration options for statement printers.
▶ To define the statement printer options
1. From the File menu select Print Setup.
2. The Printer Setup window will open.
3. In the Printer field, select the desired statement printer.
4. Click the Statement Setup button to configure the different statement printing options.

Figure 31, Statement Setup

More Info: Complete details regarding print options can be found in Help.
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Setting Up PracticeMaster
Until you are ready to start using individual features in PracticeMaster, there are just a few settings
that you will want to implement. Additional detailed information regarding how to customize
PracticeMaster for your firm can be found in the Customizing PracticeMaster Guide.

Customization
The first time you start PracticeMaster after installing the software, the Customization window will be
opened. The Customization window consists of two tabs - the Main tab and the Documents tab.
You need to define your Key Type and Decimal Places. If you are using Billing, you need to make
sure the Key Type and Decimal Places match those defined in Tabs3 Billing Customization. Details
regarding these fields can be found on page 21 of this guide and in Help.
You can leave the History Tracking options at the default. The options on the Documents tab can be
configured when you are ready to use Document Management. Detailed information can be found
in the Document Management Guide.

Figure 32, PracticeMaster Customization - Main tab

Figure 33, PracticeMaster Customization Documents tab

Worldox Note: In order to avoid conflicts, users who manage their documents using World
Software Corporation’s Worldox® programs should not configure PracticeMaster to
Automatically assign document folder and file names.
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Using PracticeMaster without Tabs3 Billing
When using Tabs3 Billing, many settings and data files that are set up in Tabs3 Billing are mirrored
over to PracticeMaster. However, if you are using PracticeMaster without Tabs3 Billing, you will need
to set up the information shown in the following table. This table includes page number references
with details on how to set up the files.

Completed Data

Information

Key Type

Page 12

Timekeepers

Page 24

Categories

Page 25

Tcodes

Page 25

Task Codes

Page 28

Location

Page 28

Clients and Contacts
Client and contacts entered in Tabs3 Billing are automatically saved in PracticeMaster.
More Info: Details regarding client and contact functionality can be found in the Clients and
Contacts Guide and in Help.
Secure Client Note: Contact information for secure clients (i.e. address/phone/email) is stored and
edited in the Client file, rather than the Contact file. This is because contact records cannot be
marked as secure; contact information is viewable by all users with browse rights to the Contact
file. Likewise, address information for clients in matter mode is stored and edited in the Client file.

Training Videos
You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/pmvideo.
Contact Management Key Concepts Video
Client Overview Video
Working with Addresses Video
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Contact Categories
PracticeMaster allows you to create categories for your contacts, thus making it easy to view
contacts by category. By default, PracticeMaster includes the following contact categories:
l
l
l
l
l
l

Attorney
Client
Client Contact
Court
Court Reporter
Judge

You can add contact categories as desired to fit your firm’s needs. Examples of other categories
include Expert Witness, Investigator, Insurance Adjuster, Doctor, Hospital, Medical Provider,
Personal, etc. Up to 20 contact categories can be assigned to each contact. Contact categories are
optional. Although you can add contact categories at any time, you may want to add the contact
categories now for those categories that you know your firm will use.
▶ To add a Contact Category
1. From the PracticeMaster menu, click File | Open | Contacts.
2. Click the Contact tab right of the List tab.
3. Find the Contact Category field and click the
Contact Categories window.
4. Click New.
5. Enter the desired Contact Category.
6. Click OK to save the new Contact Category.

button on the right side to open the

Contact categories can be used to filter which contacts you want to synchronize to Outlook and
your smartphone.

Figure 34, Contact Categories window
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/pmvideo.
Contact Usage Video

Outlook Synchronization
If desired, you can synchronize your Outlook contacts into PracticeMaster, thus allowing you to
easily create clients from the contact records. Step-by-step procedures to do this can be found in
Knowledge Base Article R11366, “Configuring PracticeMaster/Microsoft Outlook Calendar &
Contact Integration”.

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/pmvideo.
Outlook Calendar and Contact Integration Video

Areas of Practice
Although you can start using Tabs3 and PracticeMaster out of the box, when you are ready to start
using PracticeMaster for managing your matters, you will want to take the time to customize the files
to meet your firm’s needs.
You can set up separate Areas of Practice for the various types of law practiced. Each Area of
Practice has separate files for tracking unique information. For example, you might have a Family
Law area of practice, a Business Law area of practice and a Criminal Law area of Practice.
l

l

l

The Family Law area of practice might have separate files for Assets, Debts, Spouse
Information, Income, Expenses, Children, etc.
A Business Law area of practice might have separate files for Board of Directors,
shareholders, Financial Institutions, Signatories, etc.
A Criminal Law area of practice might have files for Witnesses, Prior Convictions, Bonds, Plea
Bargains, etc.

One of the easiest ways to get started with creating your firm’s areas of practice is to gather all
documents and intake forms related to that area of practice. Once gathered, highlight all of the areas
that are unique to the matter. Use this information to build or modify the files in your area of
practice.
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More Info: Details regarding how to set up Areas of Practice can be found in the Customizing
PracticeMaster Guide and in Help.

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/pmvideo.
Working with Areas of Practice Video

Calendars
The PracticeMaster Calendar is one area that most firms begin using right away in PracticeMaster.
You will want to set up calendar codes, calendar groups, and calendar rights.

Calendar Codes
Just like Outlook, PracticeMaster categorizes calendar entries as Events (i.e., appointments) or Tasks.
You can also further categorize calendar records by calendar code.
PracticeMaster starter data includes default calendar codes. We recommend you review the current
calendar codes and add calendar codes that your firm requires.
▶ To view calendar codes
1. From the PracticeMaster menu, click Calendar | Calendar Code File.
2. The List tab includes a list of Calendar Codes.

▶ To print a list of calendar codes
1. From the PracticeMaster menu, click Reports | Report Writer.
2. Highlight the Cal_Code report Name in the Report Writer window.
3. Click Print.

▶ To add a calendar code
1. From the PracticeMaster menu, click Calendar | Calendar Code File.
2. Click the
button.
3. In the New Lookup Record window, specify a key value in the New Key field. The key value is
an up to 8-character label for the calendar code.
4. Click OK.

- 46 -

Tabs3 Software Administrator Guide

5. In the Calendar Code window, specify the settings for the Calendar Code.
6. Click the

button and close the Calendar Code window.

Groups
To use the calendar efficiently, you will want to make use of groups for calendaring and scheduling
purposes.
Smaller firms with just 1 or 2 users may not use groups. However, groups are particularly useful for
firms with multiple employees. For example, perhaps one particular attorney always works with one
particular paralegal and one particular secretary. You may want to set up a group with these 3 users
for ease in scheduling. Perhaps you may want a group for all attorneys, a group for all paralegals, a
group for all clerical employees. You will want to assign a person in the firm responsibility for
maintaining the various groups as new employees are hired.
▶ To print a list of groups
l

From System Configuration, click the Reports menu, and select Group List.

▶ To add a group
l

Refer to the steps on page 11 of this guide for how to add a group.

Calendar Rights
If your firm is okay with all users seeing all calendar records on the PracticeMaster calendar, you do
not need to set up calendar rights. However, many firms want more control over who sees which
calendar records. Calendar records are considered public or private. Calendar records are public
unless the Private check box for the calendar record is selected.

Figure 35, Private check box in Calendar record

Calendar rights are defined at two different levels. First of all, you can define which users can view
the calendar. Users who have this right can view all public calendar entries for all users. This
particular right is defined in the access profile.
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▶ To create an access profile
l

Refer to the steps on page 4 of this guide for how to add an access profile.

▶ To verify the Calendar Display access right in an Access Profile
1. From System Configuration, click the File menu, point to Open, and then select Access
Profile.
2. The Access Profile window will be displayed.
a. In the groups of functions under the Access Name field, select Calendar.
b. In the list of Functions, the first item listed is Calendar Display.
c. Click Allow if you want to allow access to view the calendar. Otherwise click Disallow
if you do not want members of this access profile to have the rights to display the
calendar.
d. Click the

button and close the Access Profile window.

Figure 36, Calendar Display right in Access Profile

The second level of defining user rights is defined in the User ID record. Calendar rights can be
defined for each Logon user that is not a manager. Managers have all rights to all calendar records.
For each user, you can specify which users have rights to edit public calendar entries.
▶ To create a User ID
l

Refer to the steps on page 7 of this guide for how to create User IDs.
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▶ To edit Calendar Rights for a User ID
1. From System Configuration, click the File menu, point to Open, and then select Users.
2. Click the
button next to the User ID and select the user whose rights you want to
define.
3. Click the Calendar Rights button
4. On the Rights to this Calendar tab:
a. Select the Allow all users to edit public calendar if it is okay for all users to edit
public calendar entries. Alternatively, if you want to pick and choose which users can
edit this user’s public entries, clear the Allow all users to edit public calendar check
box.
b. Select which users you want to have Edit Public, Browse Private, and Edit Private
calendar rights.
5. Click the Rights to Other Calendars tab:
a. If you are a manager, you can select which users this user will have Edit Public,
Browse Private, and Edit Private rights for.
6. Click OK to close the Calendar Access Rights window.
7. Click

to save the changes made to the user.

Figure 37, Calendar Rights button in User record
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Figure 38, Calendar Access Rights
Rights to this Calendar tab

Figure 39, Calendar Access Rights
Rights to Other Calendars tab

Training Videos
You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/pmvideo.
Calendar Overview Video
Alarms Overview Video

Convert to Fee Settings
PracticeMaster makes it easy to convert various items into billable fee records. These fee records are
automatically mirrored over to Tabs3 Billing for billing purposes. You can convert calendar records,
document management records, and journal records to fees, including email, notes, phone,
research, and timer records.
▶ To convert a record to a Fee
l

Right-click the record and select Convert to Fee.

You can define the default settings that are used when users convert records to fees. Settings are
saved for each user and must be defined at the user’s workstation.
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▶ To define default Convert to Fee Settings
1. From the Maintenance menu in PracticeMaster, point to Preferences and select Convert to
Fee Settings.
2. Define the default settings for the record type as follows:
a. Click the corresponding tab for the desired record type (e.g., Calendar).
b. Define the settings for that record type.
c. Repeat steps a and b for each record type.
3. Click OK and close the window.
4. Repeat the above procedures for each user.

Figure 40, Convert to Fee Settings window
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Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/pmvideo.
Converting Records to Billable Fees Video

Document Management
When you are ready to start using Document Management, we recommend reading the Document
Management Guide.

Training Videos
You can view the following training videos for more information. Clicking a link will open the
associated training video in your browser. All training videos are also accessible in the software via
the Help | Training Videos menu and at Tabs3.com/pmvideo.
Getting Started with Document Management Video
Document Management Video

More Info: Knowledge Base article R11572 includes the table of contents of the Document
Management Guide and links to other document management resources.
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Setting Up Tabs3 Financial Software
Tabs3 Financial software consists of the following software:
l

Tabs3 Trust Accounting Software (TAS)

l

Tabs3 Accounts Payable Software (APS)

l

Tabs3 General Ledger Software (GLS)

The following includes information on configuring these systems and how to transfer starting
balances.
More Info: Details on the data entry programs that are used on a daily basis can be found in the
Trust Accounting Guide, Accounts Payable Guide, and the General Ledger Guide. Additional
information regarding how the software integrates with other Tabs3 software can be found in the
Integration Guide.

Tabs3 Trust Accounting Software
Tabs3 Trust Accounting Software (TAS) is designed to help your firm keep track of the trust accounts
your firm manages.

TAS Customization
The first time you start Tabs3 Trust Accounting after installing the software, the Customization
window will be opened. The Customization window consists of two tabs. There are a few fields that
must be set before proceeding. Complete details regarding the fields on each tab can be found in
Help.
▶ Configuring the TAS Customization Window
1. Start Tabs3 Trust Accounting Software. The Customization window will be opened
automatically. (Note: If the Customization window does not open automatically, use the
Utilities | Customization menu to open the window.)
2. On the Main tab:
a. Specify the desired Key Type and Decimal Places. The values in these fields are used
to define the format of the trust account and client ID. These values must match
those specified in Tabs3 Customization and PracticeMaster Customization.
Note: Details regarding the Key Type and Decimal Places can be found on page 12.
3. Click

to save the changes, then close Customization.
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Figure 41, TAS Customization - Main tab

Figure 42, TAS Customization- Merchant Services tab

Startup Files
Before using Tabs3 Trust Accounting, you need to set up the following startup information:
l
l
l

Attorney
Bank Account
Firm Payee

The following includes information on what information is stored in each of the startup files, as well
as step-by-step procedures for adding a record.

Attorney File
Attorneys are used in Trust Accounting to
designate which attorney is responsible for the
Trust Account. Each attorney is assigned a
number, name, and initials.
The attorney file in TAS is shared with the
timekeeper file in Tabs3 Billing. When
integrating with Tabs3 Billing, attorney
information must be added, changed, and
deleted using Tabs3 Billing. However, if you are
not integrating with Tabs3 Billing, you will need
to add attorneys in TAS.
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▶ To add an Attorney
1. From the TAS menu, click File | Open | Miscellaneous.
2. By default, the Attorney tab is selected. Click

.

3. Specify the attorney number you want to use.
4. Enter the remaining information for the attorney.
5. Click

to save the new attorney.

Bank Account File
You will need to define a bank
account where trust account
funds are deposited.

Figure 44, TAS Bank Account

▶ To add a Bank Account
1. From the TAS menu, click File | Open | Miscellaneous.
2. Click the Bank Account tab.
3. In the Bank Account field, select 1.
a. Enter the Account # for the bank account.
b. Enter a Description for the bank account.
c. Enter the Bank Name.
d. Specify the Last Check Number Used for this bank account. TAS will increment this
field by 1 when you enter a check that has already been printed or TAS prints the next
check.
e. Optionally select the desired Security Options.
f. If integrating with Tabs3 Billing, click the Integration Settings button.
a. Under the Tabs3 Transaction Codes for Payments section, specify the Tabs3
Billing payment transaction code you want used when funds are transferred
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to a client’s account.
b. Click OK.
4. Click

to save the new bank account.

5. Add any other bank accounts as needed.
Once your bank accounts have been defined, you can add trust accounts and specify which bank
account to use for depositing the trust funds.

Firm Payee
When integrating with Tabs3 Billing, you must
set up a payee named “FIRM”. This payee will be
used for any funds that are paid from a trust
account to your firm.

Figure 45, TAS - Payee of FIRM

▶ To add the Firm Payee
1. From the TAS menu, click File | Open | Miscellaneous.
2. Click the Payee tab.
3. In the Payee field, enter FIRM.
a. Verify your firm’s address. TAS will automatically retrieve the firm address that was
entered in the Firm Information program in System Configuration for the Payee
Address Lines.
b. Verify your firm’s Federal ID #.
c. In the 1099 Info field, specify the box number you want used for the 1099 form
generated to your firm as a payee.
d. Click

to save the payee.

When entering checks or EFTs (electronic funds transfers), you can enter FIRM in the Payee field.
When FIRM is used, Tabs3 General Ledger journal entries and Tabs3 Billing payment transactions will
be posted at the time the check or EFT is entered. However, if the check number is “0”, then the
GLS journal entries and Tabs3 Billing payment transactions will be created and posted when the
check is printed.
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Trust Accounts and Trust Transactions
Typical daily use of Trust Accounting Software generally consists of adding trust accounts and trust
transactions.
Trust
Accounts

A unique Trust ID is assigned to each individual trust account. Trust IDs use the same
client ID as Tabs3 Billing clients and matters. Each trust account is assigned a bank
account number.

Trust
Trust transactions consist of checks, deposits, and EFTs (electronic funds transfers).
Transactions When first starting to use Trust Accounting Software, you will need to enter the
starting balances for each of your trust accounts as discussed in the following “Trust
Account Balances” section. Before you can enter balances, you will need to set up
your trust accounts.
More Info: Detailed information on the Trust Account and Trust Transactions programs can be
found in the Trust Accounting Guide and in Help.

Trust Account Balances
Trust Accounting Software stores a balance for each trust account and a balance for each bank
account. These balances are automatically updated whenever a deposit, check, or EFT transaction is
entered.
When first starting to use Tabs3 Trust Accounting, trust account balances can be transferred by
entering an initial deposit. Use the Trust Accounts program to set up a trust account. Then, use the
Trust Transactions program to enter a deposit for the beginning balance. This deposit can represent
the original deposit used to open the trust account, or it can represent the trust account’s current
balance.
Initial Deposit Method

Description

Original Deposit

If you elect to enter the amount of the original deposit used to open the
trust account, you must also enter trust transactions for all subsequent
activity. This method gives you the most detail but also requires the
most time for data entry.

Current Balance

If you elect to enter the current balance as the initial deposit instead of
all history, you can enter the historical activity at a later time. If and
when you decide to enter the historical activity, either delete the
deposit transaction used to post the initial balance or enter a negative
deposit for the same amount.
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Bank Account Reconciliation Note: Keep in mind the Bank Account Reconciliation program when
deciding how much history to enter. For example, let’s say it is May 15 and you are just starting to
use Trust Accounting Software. You’ve decided you do not want to enter all of the historical
activity for all trust accounts at this time. However, you would like to start using the Bank Account
Reconciliation program for the month of May. The bank account has been reconciled with the
April bank statement. Therefore, instead of entering a deposit for the trust account’s May 15
balance, enter a deposit for the April 30th balance (i.e., the closing balance from the April 30th
bank statement). Then, enter trust transactions for all transactions that haven’t cleared as of the
April 30th balance.

Check Forms
Tabs3 Trust Accounting checks can be printed on check forms from Nelco. Laser check forms or
continuous form checks can be ordered from Nelco via their Web site at:

NelcoSolutions.com/Tabs3
More Info: Additional information and frequently asked questions regarding Nelco check forms
can be found in Knowledge Base Article R10978, “Ordering Tabs3 APS & TAS Checks and Forms
from Nelco” (support.Tabs3.com).

Configuring Check Printers
Checks are configured at the printer level via the Check Setup button in the Print Setup window.
▶ To define the default TAS check printer
1. From the File menu in TAS, select Print Setup.
2. The Printer Setup window will open.
a. In the Printer field, select the desired default printer.
b. Click Check Setup.
1. Select the desired options for the check printer setup.
2. Click OK.
3. Click OK to save the printer.
More Info: Additional information regarding printers can be found on page 13 of this guide.
Detailed information regarding each option can be found in Help.
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Figure 47, TAS Check Setup

Figure 46, TAS Printer Setup
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Tabs3 Accounts Payable Software
Tabs3 Accounts Payable Software (APS) makes bill paying easier. Invoices and manual checks
entered in APS can easily be charged to Tabs3 Billing clients and you can specify which General
Ledger accounts to post to.

APS Customization
The first time you start Tabs3 Accounts
Payable after installing the software, the
Customization window will be opened.
The Customization window consists of
three tabs. There are a few fields that must
be set before proceeding. Complete details
regarding the fields on each tab can be
found in Help.

Figure 48, APS Customization window

▶ Configuring the APS Customization Window
1. Start Tabs3 Accounts Payable Software. The Customization window will be opened
automatically. (Note: If the Customization window does not open automatically, use the
Utilities | Customization menu to open the window.)
2. On the Main tab:
a. Specify the desired number of Decimal Places you want used for the vendor
numbering format. If you do not want to use Decimal Places in your Vendor ID, leave
the value at 0.
Note: Details regarding the Decimal Places can be found in the Help.
b. Change the Default Bank to 1. We will define the bank account after saving
Customization.
3. If you are integrating with Tabs3 Billing, click the Tabs3 tab, select the Integrate with Tabs3
option and any other desired options.
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4. If you are integrating with General Ledger, click the General Ledger tab, select the Integrate
with GLS option and any other desired options.
5. Click

to save the changes, then close Customization.

Bank Account Information
Before using Tabs3 Accounts Payable, you
need to set up your bank account.

Figure 49, APS Bank Account

▶ To add a Bank Account
1. From the APS menu, click File | Open | Miscellaneous.
2. Click the Bank Account tab.
3. In the Bank Account # field, select 1.
a. Enter a Description for the bank account.
b. Specify the Last Check # used for this bank account. APS will increment this field by
1 when you enter a manual check or when APS prints the next check.
c. If integrating with GLS, specify the Cash Account # for the bank account. Optionally
specify the Accounts Payable Account #.
d. Specify which Nelco check layout will be used.
4. Click
to save the new bank account.
5. Add any other bank accounts as needed.
Once your bank accounts have been defined, you can add vendors and invoices.
More Info: Detailed information on the Vendor and Invoices programs can be found in the
Accounts Payable Guide and in Help.
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Check Forms
Tabs3 Accounts Payable checks can be printed on check forms from Nelco. Laser check forms or
continuous form checks can be ordered from Nelco via their Web site at:

NelcoSolutions.com/Tabs3
More Info: Additional information and frequently asked questions regarding Nelco check forms
can be found in Knowledge Base Article R10978, “Ordering Tabs3 APS & TAS Checks and Forms
from Nelco” (support.Tabs3.com).

Configuring Check Printers
Checks are configured at the printer level via the Check Setup button in the Print Setup window.
▶ To define the default APS check printer
1. From the File menu in APS, select Print Setup.
2. The Printer Setup window will open.
a. In the Printer field, select the desired default printer.
b. Click Check Setup.
1. Select the desired options for the check printer setup.
2. Click OK.
3. Click OK to save the printer.

Figure 51, APS Check Printer Setup

More Info: Additional information regarding
printers can be found on page 41 of this guide.
Detailed information regarding each option
can be found in Help.
Figure 50, APS Printer Setup
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Tabs3 General Ledger Software
Tabs3 General Ledger Software (GLS) is a comprehensive general ledger system for any type of
business and is based on a double-entry accounting system.

Cash Basis Accounting vs. Accrual Accounting
The majority of GLS users are on a cash basis of accounting. However, many users are on a modified
accrual basis of accounting or an accrual basis of accounting. Our accounting software can be
successfully used by any firm—no matter which type of accounting method you use. Accrual
posting features are available as described in the following.
Accrual Posting of Tabs3 Accounts Receivable Figures
Accrual Posting of Tabs3 Work-in-Process Figures
Accrual Posting of Tabs3 Client Funds Balances
The Tabs3 Billing Software can be configured so that GLS journal entries can be
posted based on balances from Tabs3 accounts receivable, work-in-process and
client funds. Journal entries can be firm wide or by primary timekeeper and can be
broken down by fees, expenses, advances, and finance charge. The software can be
configured so GLS financial statements can be run with or without accrual account
balances.
Accrual Posting of TAS Bank Account Balances
The Trust Accounting Software (TAS) can be configured so that GLS journal entries
can be posted based on TAS bank account balances. The software can be
configured so GLS financial statements can be run with or without the TAS bank
account balances.
Accrual Posting of APS Accounts Payable Figures
The Accounts Payable Software (APS) includes a feature that allows you to post GLS
journal entries on a cash basis of accounting or an accrual basis of accounting. You
have the option of posting GLS journal entries from APS after checks have been
printed and posted or before the checks have been printed. If you post GLS journal
entries on a cash basis of accounting, an optional feature is included that allows
you to post unpaid invoices, run GLS financial statements, and then unpost unpaid
invoices. This feature gives you the advantage of being on a cash basis of
accounting but still having the ability to print financial statements that include your
accounts payable figures.
More Info: Details can be found in Help in the Post Tabs3/TAS Accrual Balances program.

- 63 -

Tabs3 Software Administrator Guide

General Ledger Clients
In GLS, a client is a business entity for
which books are kept. GLS allows up to
999 sets of data to be configured, which
enables the firm to keep separate books
for multiple entities on the same
computer. If you are keeping financial
information for only one entity, then
only one GLS client needs to be set up.
Note: Integration with Tabs3 Billing,
Accounts Payable, and Trust
Accounting can only occur with
GLS Client 1.

Figure 52, Edit GLS Client window

▶ Adding GLS Client 1
1. Start Tabs3 General Ledger Software. The GLS Client window will be opened automatically.
(Note: If the GLS Client window does not open automatically, use the Utilities | Edit
GLS Client menu to open the window.)
2. Enter 1 in the Client Number field.
a. Enter the firm’s name in the Client Name field.
b. In the Account # Decimal Places, specify the number of decimal places you want
used for your account numbers.
c. Specify your Beginning Fiscal Month.
d. Change any other options as desired.
3. Click

to save the GLS Client.

Note: If you chose to include starter data when installing the Tabs3 software, GLS Client #1 was
automatically created, with a value of “2” for the Account # Decimal Places field. If you want to
change this value, you must use the Change Account # Format program (Maintenance
| Renumber | Change Account # Format).
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Journal Names
Journal entries are recorded in a specific journal.
You can use one or more journals to classify
journal entries. At least one journal must be
defined. Firms who use one journal typically
define that journal name as the General journal
and then use the Reference field in the journal
entry for classifying their journal entries.
Examples of journals include Cash Receipts,
Cash Disbursements, Miscellaneous.

Figure 53, GLS Journal Name

▶ To define a journal
1. From the GLS menu, click File | Open | Miscellaneous.
2. Click the Journal tab.
3. Enter the Journal #.
4. Enter the Journal Name.
5. Click

to save the journal.

Departments
Departments are used to classify divisions within
a business organization. You can use
departments to refer to profit centers or
locations. The use of departments is optional
and allows financial statements to be printed for
individual and combined divisions. One of the
most common uses of departments in GLS is to
create separate departments for each partner in
the firm so that financial statements can be
printed for each individual partner.

Figure 54, GLS Department Name

▶ To define a department
1.
2.
3.
4.

From the GLS menu, click File | Open | Miscellaneous.
Click the Department tab.
Enter the Department #.
Enter the Description.

5. Click

to save the department.
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Chart of Accounts
The Chart of Accounts is the “heart” of the GLS system. Because every firm’s chart of accounts is
unique, GLS provides the ability to create your own customized chart of accounts. You can use the
chart of accounts that comes with the software, modify it to fit your current account structure, or
build your own chart of accounts from scratch. To save time, we recommend using the chart of
accounts that comes with the software and modifying it as needed.
When the software was installed, an option to install starter data was provided. If the person who
installed the software elected to include starter data, you can print out the chart of accounts and use
the printed copy as a basis for determining which accounts can be deleted.
▶ To print a chart of accounts
1. From the GLS menu, click Reports | Chart of Accounts List.
2. On the Options tab, under Print Type, select Detail. A detail list will include the accounts that
journal entries can be posted to.
3. Click OK. Use the printed list to mark which accounts can be deleted.

▶ To delete an account
1. From the GLS menu, click File | Open | Chart of Accounts.
2. Highlight the account you want to delete.
3. Click

.

A Little Background About Accounts
The Print Type and Account Type fields are the most important fields to understand.
Print Type

There are 4 different Print Types:
Detail

Detail accounts are the accounts that journal entries are posted to.
Detail accounts are indented in the Chart of Accounts window.

Heading

Heading accounts are used to determine the beginning of a group of
detail accounts and can optionally print on the Balance Sheet or
Income Statements. Heading accounts are automatically paired with a
Total account and are shown as bold in the Chart of Account window.

Total

Total accounts are used to determine the end of a group of detail
accounts and can optionally print a total line on the Balance Sheet or
Income Statement. Total accounts are automatically paired with a
Heading account and are shown as bold in the Chart of Accounts
window.

Comment Comment accounts are used to print additional information on the
Balance Sheet or Income Statement.
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Account Type

There are 7 different Account Types.
Asset

Asset accounts appear on the Balance Sheet and typically
have debit balances.

Liability

Liability accounts appear on the Balance Sheet and
typically have credit balances.

Income

Income accounts appear on the Income Statement and
typically have credit balances.

Expense

Expense accounts appear on the Income Statement and
typically have debit balances.

Bank Account

Bank Accounts are a type of asset account that can be
reconciled.

Credit Card

Credit Card accounts are a type of liability account that
can be reconciled.

Retained Earnings

There can be only one Retained Earnings account. The
Retained Earnings account balance is calculated as Assets
minus Liabilities, plus or minus any journal entries posted
to the account.

Figure 55 shows the Chart of Accounts window. You can drag and drop accounts to their desired
position.

Figure 55, GLS Chart of Accounts window

Double-clicking an account opens the Account Setup window. The Account Setup window has two
tabs, the Account tab and the Report Options tab as shown in Figure 56 and Figure 57.
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Figure 56, Account tab of GLS Account Setup

Figure 57, Report Options tab of GLS Account Setup

▶ To add a new account
1. From the GLS menu, click File | Open | Chart of Accounts.
2. In the Chart of Accounts window, highlight the account above the account you want to add.
3. Click
.
4. Specify the account number you want to use and click OK.
5. The Account Setup window will be displayed.
a. Enter the account Description.
b. Specify the Account Type.
c. Specify the Print Type.
i. If the Print Type is a Bank Account or Credit Card, click the Bank Info or
Card Info button to enter bank or credit card information.
d. Specify any other settings.
6. Click Save.

Posting Beginning Balances
Beginning balances are transferred to General Ledger by posting journal entries. Before you can post
journal entries, your chart of accounts must be defined.

Determine Starting Date & Posting Date
Before posting beginning balances, you will need to determine your starting date, which is the first
day of the month that you want to begin using GLS. Then, when posting journal entries for
beginning balances, you will use the day prior to the starting date.
Examples
l
l
l

If your starting date is April 1, then you will use a March 31 posting date.
If your starting date is October 1, then you will use a September 30 posting date.
If your starting date is January 1, 2019, then you will use a December 31, 2018 posting date.
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Post Journal Entries for Starting Balances
Once you have determined your starting date, you can post starting balances as follows.
l

l

l

You will post a single transaction that includes a journal entry for each account.
All journal entries must use the same date. Use the day prior to your starting date for your
posting date.
Your accounts must be in balance before you can save the transaction.

Asset & Liability Accounts

Use the account’s closing balance as of the posting date.
l

For example, if you want to begin using GLS in May 2019,
use April 30, 2019 for your posting date and the account’s
closing balance as of April 30, 2019.

Bank Account Note: When posting starting balances for bank
accounts, use the closing balance for the account from your
previous bookkeeping system, rather than the balance provided
by your banking institution. Using the account balance provided
by your bank will result in an incorrect account balance if there
are any outstanding transactions (e.g., uncleared checks or
deposits).
Outstanding Checks and Deposits Note: Before performing
your first reconciliation, you must enter journal entries for any
outstanding checks and deposits. You can do this now or later.
Use the same account number for both the debit and credit
entry. Step by step instructions for entering outstanding
transactions and performing the initial reconciliation can be
found in Knowledge Base article R11661, “GLS Reconciliation
Troubleshooting” (support.Tabs3.com).
Income & Expense Accounts

Use the account’s cumulative YTD balance as of the posting date.
l

For example, if you want to begin using GLS in May 2019,
use April 30, 2019 for your posting date and the account’s
cumulative YTD balance as of April 30, 2019.
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Retained Earnings Account

Your retained earnings account may or may not require a journal
entry.
l

l

If your retained earnings account started the year with a
zero balance, your debits and credits will be in balance and
no journal entry to the retained earnings account is
required.
If your retained earnings account balance is carried over
from the previous year, you will need to post a journal
entry for the account balance as of the beginning of the
year. Use the same posting date as the other journal
entries. After making this journal entry, your debits and
credits should be in balance.

More Info: Detailed information regarding the Journal Entries program can be found in the
General Ledger Guide or in Help by pressing F1.
Once you have entered balances for all accounts in the transaction, save the transaction. You can
verify your balances by printing a Balance Sheet and Income Statement using the month of your
starting date for the Calendar Month to Print.
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Platinum & Tabs3 Connect
If you are using Platinum software, you will need to configure HotBackup and Tabs3 Connect. The
Installation Guide includes a great introduction to Platinum software and the various configuration
screens used.

Configuring HotBackup
Once the Platinum software has been installed, you can enable HotBackup, set up the HotBackup
schedule, and configure the email messages you want sent when a HotBackup successfully
completes or does not complete. Detailed information on HotBackup can be found in the
Installation Guide and the Platinum Server Guide. Additionally, you can find detailed field level
information in System Configuration Help for the various windows. Knowledge Base article R11193,
HotBackup Overview, also includes detailed information regarding HotBackup.

Configuring Tabs3 Connect
Once Tabs3 Connect has been configured, you can designate which users can use Tabs3 Connect.
Detailed information on configuring Tabs3 Connect and enabling users can be found in the
Installation Guide and System Configuration Help. Knowledge Base article R11480, All About
Tabs3 Connect, includes comprehensive information about Tabs3 Connect.

- 71 -

Tabs3 Software Administrator Guide

Configuring Advanced Features
Credit Card Processing
Tabs3 Billing and Tabs3 Trust Accounting allows credit card processing for payment transactions,
client funds deposit transactions, and trust account deposit transactions at the time of entry. Tabs3
credit card processing uses merchant accounts from TSYSSM Merchant Solutions (formerly First
National Merchant Solutions®). TSYSSM Merchant Solutions is a top 10 payment processor with
more than 50 years of experience providing first-rate service and solutions to businesses across the
nation.
Configuring merchant accounts is done in Tabs3 Billing Customization and TAS Customization via
the Merchant Services tab as shown in the following figures.

Figure 58, Merchant Services tab in
Tabs3 Billing Customization

Figure 59, Merchant Services tab in
TAS Customization

More Info: Complete details regarding Credit Card Processing can be found in the Tabs3 Credit
Card Processing Guide.

Document Management
PracticeMaster includes enhanced Document Management features that help your firm track all
types of documents. You can create a convention for document names and locations, and then let
PracticeMaster automatically name and file your documents. You can create your own document
types for use in classifying, naming, and storing documents in a manner that meets your firm’s
needs. Check Out and Check In features let you check out documents to prevent others from editing
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them while you are working on them. You can also create versions of documents, which enhances
your ability to track changes during the editing and review process. Instantly save and update
managed documents from Word, Adobe, Outlook, Excel, PowerPoint, WordPerfect, and Outlook
email attachments. A powerful import feature lets you import entire groups of documents at one
time directly from Windows Explorer and organize them in PracticeMaster.
More Info: Complete information regarding Document Management in PracticeMaster can be
found in the Document Management Guide. Appendix A of this guide includes a Getting Started
Checklist.

Taskbill
Many larger corporations, particularly insurance companies, commonly require law firms to submit
their invoices in an electronic format that conforms to a specific format as required by an electronic
billing service. These formats have very specific and unique requirements regarding how the
information must be submitted. Tabs3 Taskbill software was designed to meet these specific
requirements and currently supports over 100 different formats. Knowledge Base article R10435,
Tabs3 Taskbill Product Information, includes information regarding the formats that Taskbill
supports.
Many company’s formats require task based billing. Enabling task based billing for a client allows
you to enter phase and activity/expense codes when inputting fees and costs. These codes are based
on the Universal Task-Based Management system (or UTBMS).
More Info: Additional information regarding task based billing can be found in the Billing
Methods Guide.
More Info: Additional information regarding how to install and configure Taskbill can be found in
the Knowledge Base and in the Help provided with Taskbill.

Training Videos
You can view the following training video for more information. Clicking the image will open the
training video in your browser. All training videos are also accessible in the software via the Help |
Training Videos menu and at Tabs3.com/t3video.
Task Based Billing and Taskbill Video
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Administrative Maintenance
The following section of this guide includes best practices regarding general usage.

General Usage Tips
Use the following tips to keep the software running at its best.

Exit the Software Before Turning Off the Computer
It is important that all users exit the software properly before turning off the computer. You can use
any of the following methods to exit the software.
l

From the File menu, click Exit

l

Click the Close button on the title bar

Active User List
The Active User List (View | Active User List) shows which users are in the software. Managers can
select the All Systems check box to optionally view all users in all of the software. Additionally,
managers have the right to reset individual users.

Figure 60, Active User List window

Resetting Users
When a user exits the software properly, the Active User List is updated. If a users does not exit the
software properly, the user must be reset. For example, if a user’s computer is accidentally
unplugged while the software is open, that user must be reset. That same user can reset himself, or a
manager can reset him. However, non-manager users cannot reset other users.
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Although it is necessary in certain circumstances to have to reset users, it should be the exception as
opposed to the rule. Users that are in the software should never be reset. Resetting users that are in
the software can cause data loss, data corruption, and fatal errors. If it becomes necessary to reset a
user, contact the user and ask them to log out. If the user is unavailable, go to the user’s computer
and close the program(s) yourself.
You can see which users have been reset by viewing the reset log file (View | Log Files | Reset Log).
More Info: Knowledge Base article R10789, Resetting Users, includes detailed information
regarding resetting users and how to reduce the frequency of resets.

Startup Options
The Tabs3 software includes various startup options that can be used when starting the software. We
recommend familiarizing yourself with the various options available.
One startup option that most firms like to implement is the ability to bypass the User ID in the Logon
window. You can modify the desktop shortcuts to include the User ID so that the user does not have
to type in their User ID every time they start the software.
More Info: The Help for each Tabs3 product includes detailed information regarding startup
options.

Month-End/Year-End Procedures
There are several tasks that must be performed at month-end and year-end for the Tabs3 Billing,
General Ledger, Accounts Payable, and Trust Accounting software. Checklists with these monthly
tasks can be found in each product’s built-in Help files under the “Month-End Procedures” index
entry. Procedures for year-end tasks can be found in the following Knowledge Base articles.
R10429 Year-End Overviews for Tabs3 Software Products
R11693 Tabs3 Billing Year-End Overview
R11600 General Ledger Software Year-End Overview
R11278 Accounts Payable Software Year-End Overview
R10433 Trust Accounting Software Year-End Overview

Backup Best Practices
Tabs3 software includes a built-in backup feature. In addition to using the built-in backup, it is
important that you implement another backup method. A thorough discussion of the backup
options can be found in Knowledge Base article R11213 - Backup Strategy.
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Integrity Check Programs
Tabs3 software includes built-in utility programs that check the integrity of the data. We recommend
that these programs be run on a monthly basis and also prior to all backups. In addition, these
programs should be run if a hardware failure occurs while using the software (i.e., power failure,
power surge, etc.).

Program
Tabs3 Billing

Menu
Utilities | Data File Integrity Check
Utilities | Archive Integrity Check

PracticeMaster

Utilities | Data File Integrity Check

Trust Accounting Utilities | Data File Integrity Check
Accounts Payable Utilities | Data File Integrity Check
General Ledger

Utilities | Data File Integrity Check

After the Data File Integrity Check completes, verify that there are zero errors. If errors are
encountered, review the Error Report and resolve the errors before continuing to use the software.
More Info: Knowledge Base article R11751, Data File Integrity Check Errors, includes detailed
information on how to resolve any data file integrity check errors that may occur. Likewise,
Knowledge Base article R10771, Archive File Integrity Check Errors, includes detailed information
on how to resolve any archive file integrity check errors that may occur.

Tracking Tools
Tabs3 software includes various tools to help you track software activity.

Verification Lists
Verification lists are lists of activity that has occurred.
Each user can run a list of all transactions that have been entered. For example, the Tabs3 Billing Fee
Verification file includes a list of all fee transactions that have been added, changed, and deleted.
Users can review their own verification lists or they can submit them to an administrator for review
purposes.
More Info: Examples of the various verification lists are available in the Sample Reports. Select
Help | Documentation for a list of all available resources.
More Info: Knowledge Base article R10793, All About Verification Lists, includes detailed
information regarding the various verification lists in Tabs3 software.
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Log Files
Log files track multiple activities in the Tabs3 software. Multiple log files are available for each
program. They can be very useful in tracking down the cause of errors and determining when
changes were made.
The following log files are maintained in the software for troubleshooting purposes and can be
accessed via the View menu by pointing to the Log Files menu option.
Error Log
(All Programs)

The Error Log tracks any fatal errors that occur in the
software.

Reset Log
(All Programs)

The Reset Log tracks information regarding when users are
reset using the Active User List program.

Support Log
(All Programs)

The Support Log tracks various activities performed in the
software.

Outlook Sync Billing Changes Log
(Tabs3 Billing)

The Outlook Sync Billing Changes Log tracks changes to
Bill To contacts made by the Outlook Synchronization
process in PracticeMaster.

Outlook Sync Log
(PracticeMaster)

The Outlook Sync Log tracks information on the changes
made during the Outlook Synchronization process.

Outlook Search Log
(PracticeMaster)

The Outlook Search Log stores any errors that occur while
PracticeMaster updates email records in Outlook.

Tabs3 Connect Log
(System Configuration)

The Tabs3 Connect Log is a detailed log file used for
reviewing chronological Tabs3 Connect activity and
troubleshooting connection issues.

Tabs3 Connect Access Log
(System Configuration)

The Tabs3 Connect Access Log tracks user access to Tabs3
Connect and records occurrences of log ins, log outs, lock
outs, and downloads of documents and email
attachments.

Submit Log Files
Menu: Help | Internet Resources | Submit Log Files

The Submit Log Files program (Figure 61) is used to provide log file information to Technical Support
for troubleshooting purposes via the Internet. Before the requested log files can be submitted, you
will be required to enter an Incident ID, which will be provided by the Technical Support
Representative with whom you are speaking.
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Figure 61, Submit Log Files window

Incident ID

The Incident ID will be provided by the Support
Representative that you are speaking with on the phone.
The Incident ID will be a 4-character code. Until this field
is filled in, the Send button will remain unavailable.

The Advanced button opens the Advanced File Selection window, which allows you to select
additional log files to be submitted to Technical Support.
The Send button will submit all files that were selected in the Advanced File Selection window, but
only becomes available after the Incident ID has been entered.

History Tracking
History Tracking is an optional feature in PracticeMaster that can be used to track all additions and
changes to specific fields in a file. History Tracking does not track deletions.
By default, History Tracking is not enabled. When History Tracking is enabled, additional activity is
performed by PracticeMaster. PracticeMaster performs additional writing to the hard drive every
time a record is added or changed for any file that has a field configured to track history. Therefore,
we recommend enabling History Tracking for only those fields that require it.

How to Configure History Tracking
History tracking is configured at two levels—the system level and for each individual field.
▶ To configure History Tracking at the System Level
1. From the PracticeMaster menu, click Utilities | Customization.
2. Select the Use History Tracking check box.
3. If you want to limit the size of the History Tracking file, select Limit history file size and
specify the maximum size (in megabytes) that you want to allow the History Tracking file to
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reach.
4. Click OK to save the Customization settings.

▶ To configure History Tracking for an Individual Field
1. From PracticeMaster menu, click Maintenance | File Maintenance.
2. Click the + next to System Files or Areas of Practice to display the corresponding list(s) of
files.
3. Once you have selected the desired file, right-click the file and choose Edit Field Definitions.
...or...
Alternatively, double-click the file and select the Field tab.
4. The File Definition window will be displayed. Highlight the field you want to change in the
Field IDs list.
5. Select the Track History check box.
6. Click Done to save the change.
Note: The Help | About PracticeMaster window indicates whether History Tracking is enabled,
the user defined maximum History File size, and the combined size of the current History Files.

Viewing the History File
Viewing the History File is accomplished via the Editor window.
▶ To view the History File
1. From the File menu, point to Open and select the file whose history you want to view.
2. From the List tab, highlight the desired record.
3. Right-click the highlighted record, point to Action and then select Display History.
4. If changes have been made, the View Record History window will be displayed allowing you
to browse through the changes. Otherwise, a message will displayed indicating history
tracking cannot be displayed.

When the History File Gets Too Large
The history for all configured fields is maintained in a single set of files named CMAUDIT.DAT and
CMAUDIT.IDX. Depending on which fields are using History Tracking, these files have the potential
of becoming extremely large. Because of this, you have the ability to specify a maximum History File
Size. Once the files have reached their size limit, any data written to the History Tracking File will
begin replacing the oldest data to make room for the new data.
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When the size of the CMAUDIT.DAT file is within 10% of the specified maximum size, a message will
be displayed when PracticeMaster is started. This message indicates that the maximum history
tracking file size will soon be reached. You can either increase the maximum file size or leave it at its
current size. If you leave the file at its current size, the message will be displayed again the next time
PracticeMaster is started. If you select the Do not show again check box, the message will not be
displayed again for you (unless the user profile is reset or you run the Reset Optional Messages
program).

Miscellaneous Notes
History tracking is available for all files whose file structure can be modified. However, history
tracking is not available for the following files:
l
l
l
l
l
l
l
l
l

Timekeeper File
Category File
Tcode File
Task Code File
User File
Text Macro File
Location File
eNote File
Secure Client File
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Resources
There are many resources available to help you learn and use the software.

Guides & Quick Guides
There are multiple guides installed with the software. Select Help | Documentation for a list of all
available resources. The guides can also be accessed via our Web site at:

Tabs3.com/support/docs.html

Report Packs
Report packs are available for all software. These report packs includes examples of each report in
the software and include detailed information regarding each item on the report. Select Help |
Documentation for a list of all available resources. The sample reports can also be accessed via our
Web site at:

Tabs3.com/support/docs.html

Training Videos
Training videos are multimedia resources that walk you through Tabs3 Billing and PracticeMaster
features. Select Help | Training Videos to access the training video libraries. The training videos can
also be accessed at:

Tabs3.com/videos

Knowledge Base
The Knowledge Base includes information regarding Tabs3 software products and is provided for
end-users, consultants, and other third parties who work with Tabs3 software. It contains extensive
information on Error Troubleshooting, Networking & Windows Issues, “How To” articles and
product-related articles. The Knowledge Base requires Internet access. Select Help | Internet
Resources | Knowledge Base to access the Knowledge Base. The Knowledge Base can also be
accessed at:

support.Tabs3.com
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Help
Help is installed with the software and is easily accessed by pressing F1, by clicking the
button,
or by selecting the Help | Help Topics menu option. Help includes detailed information regarding
specific programs. Clicking the
button opens Help for the window you are currently using. Many
times, reading the appropriate Help topic may be the fastest way to find your answer.

Technical Support
Tabs3 provides some of the best technical support in the industry. Service to our customers is
extremely important to us—so much so that our motto is:

Reliable software. Trusted service.
Technical support is provided at no charge with a maintenance plan and is available from 8:00 a.m.
to 5:00 p.m. Central Time, Monday through Friday. If you have any questions, please feel free to call
our Technical Support staff at (402) 419-2210.
Email support is also available for all firms on maintenance. Our support team responds to emails
during office hours. Our goal is to respond to your question within one business day. Please keep in
mind that time-sensitive and complex issues are better handled over the phone. To request email
support, visit Tabs3.com/support.

Tabs3 Consultants
Tabs3 software products are available through a national network of over 250 consultants. Those
consultants are small independent firms that specialize in the sales, installation, training and support
of billing, financial, and practice management software for law firms. By having consultants service
all 50 states, you can work directly with a local person familiar with Tabs3 software, who can provide
personalized on-site installation, training, and support services. Visit our Web site for a consultant
near you or contact our Sales staff at (402) 419-2200.

Tabs3.com/find-a-consultant

Thank you for choosing Tabs3 software. We look forward to serving your practice management and
billing needs with reliable software and trusted service for many years to come. Let us know how we
can help you get started with Tabs3 and PracticeMaster.
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73
Tcodes
See Transaction Codes
Technical Support
2, 82
Threshold Billing
39
Timekeeper Levels
23
adding
24
definition
23
Timekeepers
24
adding
24
definition
24
security
9
vs. users
24
Tips
general usage
74
Tracking Tools
76
History Tracking
78
log files
77
verification lists
76
Training Videos
81

Transaction Codes
adding
Transition Date
Trust Account Balances
Trust Accounting Guide
Trust Accounting Software
accounts
adding bank accounts
Attorney file
balances
bank account file
checks
customization
firm payee
startup files
transactions
Trust Accounts
definition
Trust Transactions
definition

25
26
30
57
57
57
55
54
57
55
58
53
56
54
57
57
57
57
57

U
User Configuration Window
example
Users
adding
assigned timekeepers
Blank User ID
Outlook integration
passwords
resetting
setting up
shared resources
User Configuration window example
User ID definition

8
7
9
8
8
9
74
7
8
8
9

V
Value Billing
Verification Lists
examples
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39
76
76

Tabs3 Software Administrator Guide

Videos
area of practice
billing methods
billing rates
calendar
contact usage in PracticeMaster
converting records to fees
document management
PracticeMaster clients and contacts
receipt allocation
statements
Tabs3 clients and contacts
Taskbill
Viewing
calendar codes

81
46
39
36
50
45
52
52
43
39
40
29
73
46

W
Work-in-Process Balances

35

Y
Year-End Procedures

75
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